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    Contents for Raffle Do Help
Raffle Do outputs raffle ticket templates to laser and compatible printers.      Choose either 4x1UP or 
4x2UP raffle ticket templates.      4x1UP template has four large tickets and 4x2UP has eight smaller 
tickets.      Print up to one million tickets, starting and ending at any number between 0 and 999999.      
Easily print backup copies of one or more templates.

Use the Numset template to sequentially number any paper stock that will run through a laser or 
compatible printer.      Numset is an automated numbering system.      It is a small scale alternative to high 
priced numbering machines and can perform many of the same tasks.      Number documents, self-
adhesive labels, pictures, tickets, forms, etc.

To learn how to use help, press the F1 key.
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Raffle Do Menu Commands

There are three menu commands that control the development of all Raffle Do templates:

File Menu Commands
Options Menu Commands
Help Menu Commands

Also See
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File Menu Commands

Open 

Open one of three available templates.      The 4x1UP template has four large tickets, each with four 
labels on its stub.      This template prints out in landscape mode.      4x2UP template has eight smaller 
tickets, each with five labels on its stub.      4x2UP templates printout in portrait mode.      The Numset 
template will print up to 33 labels per template (sequential numbers with or without leading and/or trailing
text) in portrait or landscape modes. 

Print All

Choosing Print All displays the Print All dialog box

Print One

Choosing Print One displays the Print One dialog box

Printer Setup

Choosing Printer Setup will open a printer setup dialog box.      Use it to make your laser or compatible 
printer the active printer and to set the printer in portrait or landscape mode.

Exit

The Exit command displays a message box with an option to terminate Raffle Do operation.



Options Menu Commands

This menu has tools to customize a template.      You an customize or reset labels on raffle tickets stubs 
and format sequential numbers on all templates.      Note that Number Format is the only menu option 
available for Numset.      When an option is chosen, the on-screen template will reflect the changes.      
The status bar states the current status of all options.

Blank Label

Choose it to delete the label with the focus.      Choose it again to remove this feature.      Once this option
is turned OFF, then ON, a line will appear in the affected label.      After activating the reset option, the 
blank label option is set to OFF for all labels.      The blank label button "BL" is located in the design bar 
for quick access.

Reset All Labels

This option will reset every label to default settings.      The editing focus will be set to label one.      The 
current font and the number format are not affected.      The reset button "RS" is located on the design 
bar for quick access.

Numbers On/Off

You may not want raffle ticket templates with any numbers.      Choose Numbers On/Off to accomplish 
this.      Choose it again to display numbers.    

Also see

Number format



Raffle Do Procedures

Access these topics to learn how to create templates.      Beginners can start with the introduction, then 
learn about the main window functions.      Read the entire Numset topic before using Numset.      Review
the printing process before printing large template stacks.

Introduction
Quick Start

Navigating around the main window
Main Window Information
Design Bar
Status Bar

The Numset program
Numset

The Printing Process
Print All
Print One
Raffle ticket sequential numbers
Printers
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Quick Start

To quickly attain productivity, follow each instruction.      After starting the program, the main window with 
the 4x1UP raffle ticket template will appear on-screen.      Produce one template first, then make a 
template stack.      To effectively use Numset, read its entire section.      Perform these steps after exiting 
this help file.      Choose Print Topic from the File menu of this help file to get a printout of this topic.

1.    Set up your laser printer.      Make sure it's the active printer and in landscape mode for 4x1UP or 
portrait mode for 4x2UP.

2.    To choose the 4x2UP template, press F3 key.      Press the F2 key to return to the 4x1UP template.
3.    Choose fonts in the design bar.

a.      Choose a font.
b.      View the changes on the on-screen template.

4.    Print a sample    template.      Press the F6 key to open the Print One dialog box.
a.      Enter a range of 1 to 1000    (no leading zeros; zero is 0, not 0000).
b.      Enter a starting ticket number of 17.
c.      Choose either horizontal or vertical sequential numbers    See raffle ticket sequential numbers. 

Click the OK button to print out one template.      To get a printout of a template with other fonts, follow 
steps 1 to 3 again.      The total time to print a template stack is vital.      See timing.

      
5.    Once you are satisfied with the appearance of the template, press the F5 key to open the Print All 

dialog box.      If you want to print no more than 10000 tickets,
a.      Enter a number between 0 and 9996 as the "first number".
b.      Enter a number between 3 and 9999 as the "last number".
c.      Choose either horizontal or vertical sequential numbers.      See raffle ticket sequential numbers.

If you want to print up to 99999 or 999999 tickets, choose Ten Thousands or Hundred Thousands 
from the Options + Number Format sub menu, respectively.      

Click the OK button to print out a template stack.      Press the ESC key to cancel printing any    time 
while the escape message appears in the "Printing..." message box.

Example: To printout 1000 raffle tickets, starting with sequential number 1, enter 1 for the first 
number and 1000 for the last number.      Choose either horizontal or vertical sequential 
numbers.      Click the OK button.      For the 4x1UP, a template stack of 250 templates, 
each with 4 raffle ticket headings will printout.      For 4x2UP, a template stack of 125 
templates, each with 8 raffle ticket headings will printout.

For instructions on how to customize labels or printing templates without labels, go to Options 
Commands.

If    you want to change the template position on the page, change the margin settings of the printer.     
Consult your printer's user guide for more information on changing margin settings.
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Main Window Information

The main window is the screen or window that displays at start-up.      It remains on-screen until Raffle 
Do operation is terminated.      You cannot re-size the main window.      You can however reduce it to an 
icon.      To do so, click the button in the uppermost right corner of the main window or choose Minimize 
from the System menu.      The main window consists of a menu bar, design bar, status bar, scroll bars 
and an on-screen template as shown.
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Design Bar

The purpose of the design bar is to customize the template and allow quick access to frequently used 
features.      When either raffle ticket template is open, you can change fonts; set the editing focus; 
customize text in a label; delete the contents of a label and reset all label contents to the default setting.

Fonts

A drop down combination box titled "Fonts:" contains two fonts: helvetica and times roman.      The 
4x1UP and 4x2UP template have access to helvetica and times roman fonts.      Numset has access to 
only the helvetica font.

To choose a font, click on the arrow to display available fonts and then click mouse pointer on chosen 
font.      Or, press the key representing the first letter of an available font.      The on-screen template will 
reflect the change to the new font.      ALWAYS choose a font before customizing labels.      Changing 
fonts will always reset all labels to default settings.

Label

The second drop down combination box titled "Label:" will set the editing focus on one of four or one of 
five labels.      Choosing a label will display its text in the text box.      You can then customize text in that 
label.

Note that each stub has the same number of labels.      Label one is the first label on each stub.      
Altering label one of stub one will alter the first label of all stubs, and so on.

Text

Use the text box to enter characters to change the text for the label with the focus.      Any character, up 
to 15, are allowed, except the underline character.      All labels, unless its contents are deleted, will have 
lines (the underline characters).

To change text for the label with the focus, insert text and then press the RETURN key or click on the 
OK button.      Label X of each stub will contain the new text.

To make a label appear with only a line, delete all characters from the text box and press the RETURN 
key or click the OK button.

Blank label

The "Blank Label" option is available in the design bar.      Click the button marked "BL" or press ALT + B 
keys to delete the contents of the label with the focus.      Activate it again to turn this option OFF.      The 
status bar states the current status of this option.      See Option Commands for more information.

Reset labels

The "Reset All Labels" option is also available in the design bar.      Click the button marked "RS" or press
the ALT+R keys to reset all labels to the default settings.      See Option Commands for more information.
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Design Bar Controls for Numset

When the Numset template is open, the leftmost button is the only available control in the design bar.      
Notice that the combination box for labels and the text box are empty.      The fonts combination box 
states "Helv" as the font.      

Once the template is configured, the Numset dialog box closes.      To re-edit or completely re-configure a
template, open its dialog box again.      Click the "NM" button or press the ALT+M keys to open its dialog 
box.      You can also double click on the on-screen template.



Status Bar

The status bar is located at the bottom of the main window.      It lists the current status of several of the 
most frequently used options and features.      Instead of opening menus or dialog boxes to remind you 
of the current status of an option or feature, look at information contained in the status bar.      The status 
bar is useful when making decisions before printing.

When either raffle ticket template is open, the following information appears in the status bar:

Label Status
BLANK LABEL ON/OFF See Options Menu Commands
NUMBERS ON/OFF See Options Menu Commands
NUMBER FORMAT See number format

When the Numset template is open, the following information appears:

Label Status
X      COLUMNS The number of columns you configured in the present template.      See 

Numset.
X      ROWS The number of rows you configured in the present template.      See 

Numset.
PORTRAIT/LANDSCAPE The page mode of the on-screen template.      Set your printer to this 

mode before printing.
NUMBER FORMAT See number format

Note that ON/OFF will not appear together.      Either ON or OFF will appear.      Either PORTRAIT or 
LANDSCAPE will appear also.      "X" is a number.      The name of the current number format will appear 
following NUMBER FORMAT.



Number Format

This option formats sequential numbers.      Choose it to see the sub menu with its five number formats.   
The number format is the maximum number of digits that appear as sequential numbers.      All options, 
except NONE, have leading zeros.      Note that NONE is available for Numset.      NONE means 
sequential numbers have no leading zeros.      The following table shows the number format, its actual 
format and the maximum number.      The actual format is the amount of leading zeros, where "X" is a 
leading zero.

When Raffle Do starts up, the 4x1UP raffle ticket template is opened and the number format is 
"Thousands" (default number format).      When Numset is opened, the number format is "NONE" which is 
the default setting for Numset.

The current format is checked in the sub menu.      When a new one is chosen, the on-screen template 
reflects the change.

When you print out a template stack, the maximum last number cannot surpass the number format 
setting.      If it does, Raffle Do will state an error and allow you to correct it.

When printing raffle tickets, use this option only after careful consideration.      Make sure that the 
template stack will not grow beyond the chosen number format in the future.      If so, the original 
template stack and the add-on to the template stack will have a different number format.      This will 
appear awkward to the customer.



Numset

Numset is an automated numbering system.      Designing a Numset template is a straightforward 
process.      Choose Numset form the File + Open sub menu to open Numset.      Its dialog box appears.   
You must configure a template, which consists of cells.      A cell is similar to a cell in a spreadsheet.      
One cell is the intersection of one column and on row.      To configure the template:

1.    Insert the number of columns one template will have, then the number of rows.      The maximum 
number of columns for portrait mode printing is three; eight for landscape.      The maximum number of
rows for portrait mode printing is eleven; four for landscape.      See examples.

2.    Insert the left and top coordinates for the sequential number in each cell.      You do not have to 
literally insert coordinates for every number on the template.      Set coordinates for one number, the 
uppermost left one, and the coordinates will be the same in all cells.

The maximum setting for the left coordinate is 0.25 " from the left edge of the cell    and 0.25" from the
right edge of the cell.      The maximum setting for the top coordinate is 0.25" from the top edge of the 
cell and 0.25" from the bottom edge of the cell.      Enter both left and top coordinates in inches.

3.    Each number can have leading and trailing text.      Leading text is text that precedes the number.      
Trailing text is text that follow the number.      A maximum of 15 characters for either is allowed (30 
total).      You do not have to enter a space at the end of the leading text or preceding the trailing text in
order to separate text and numbers.      Numset automatically adds these spaces.

Note that sequential numbers alone or sequential numbers with leading and/or text is 
called a label.

Leading and trailing text is useful when you want to inform a customer about the name or total 
quantity of the product that is numbered.

Example:        Disk 1 of 3 ;where "Disk" is the leading text and describes the type or name of a 
product, "1" is the sequential number and "of 3" is the trailing text and 
describes the total quantity.

4.    Set the mode of the on-screen template to portrait or landscape.      You should consider which mode 
to use before stating all other details.      Remember to set you printer mode to match the mode set 
here.

5.    After configuring the template click the OK button or press ALT+ K keys.      The on-screen template 
will be configured as you designed it.      The red lines represent borders of each cell.      The red lines 
will not print out when you print templates.      The vertical red lines only appear if their are 2 or more 
columns.      The horizontal lines only appear if there are 2 or more rows.

If you placed the left or top coordinate beyond its limits, an error message will display then allow you to 
correct the error.      Note that leading and trailing text with many characters, as well as long number 
formats, may expand the label beyond valid limits.

Review the on-screen template and ensure that the label is correct before printing.      Numbers are 
represented by an uppercase "X".      When Numset first opens, its number format is set to NONE.      To 
change it, choose Number format from the Options menu.      The template will display the label with the 



updated format.      If the new digit format extends the label beyond its valid limits the new number format
is dropped and the last valid one is chosen.

If the number format is NONE, the position of the labels will change depending on the amount of digits of
the last number printed.      Numset prints its labels left justified.      Make sure there is enough space per 
cell to account for this or else labels may overlap cells or not print at all.

You may want to re-edit or design a new template.      The Numset dialog box must be opened again.      
To open the dialog box again, click the "NM" button on the design bar, press the ALT+M keys or the 
RETURN key.

Once you are satisfied with the template layout, start printing.      Choose Printer Setup and set the 
printer mode to match the page mode.      Choose Print All from the File menu or double click on the on-
screen template.      Insert first and last numbers, repeat and skip options if necessary, then click OK 
button to print.      See Print All dialog box.



Numset Examples

1.    If you want to place one number on a page, centered near the bottom, then the template will have 
one column and one row.

2.    To print a number on a plugger (a big ticket the size of 1/4 a letter size page), simply state two 
columns and two rows if you will paste four pluggers on a page and then print them.      You should, of
course, print all pluggers, number them and then cut each sheet into 4 pluggers.

3.    If you want to number self-adhesive labels, count the number of labels on one sheet, treating each 
label as a cell.      A sheet of 33 labels with 3 across and 11 down is simply 3 columns and 11 rows (a 
total of 33 cells).

Note that all tickets or labels must be equally spaced on the page.      Numset equally spaces its 
sequential numbers.



Print All dialog box

Open this dialog box to print a template stack.      Choose Print All from the File menu in the main 
window.      Set the range ("first number" and    "last number") and sequential number in this dialog box.     
An explanation follows.

First number

Insert the first raffle ticket or Numset number in the text box with this label.      The first    sequential 
number on the first template will start with this number.      A valid entry is any number between 0 and 
999996, depending on the number format.

Last number

Insert the last raffle ticket or Numset number in the text box with this label.      The last    sequential 
number on the last template will end with this number.      A valid entry is any number between 3 and 
999999.      The number format setting effects the maximum entry allowed for the last number.      For 
example, if the number format is set at "Thousands" then the maximum last number is 9999.

Note that the last sequential number is always determined by how many templates are printed.    If the 
formula below does not yield a whole number, then the actual last sequential number is (up to 3) or (up 
to 7) more than the last number inserted.

x = [(last number - "first number") + 1] / t ;where t = 4 for 4x1UP and t = 8 for 4x2UP

Numbers

Sequential numbers that progress in a forward count.      Raffle ticket sequential numbers can print either 
horizontal or vertical in a template stack.

Repeat

The repeat option is only available for Numset.      You can repeat a sequence of a range of numbers.      
The maximum amount of repeated sequences is 9999.      Click its check box to turn ON.      A default 
repeat sequence of "2" (repeat once - printed twice) is set in the text box.    You can then set any amount
between 2 and 9999.

To effectively use this option, you must consider the range of numbers (first and last numbers entered in 
this dialog box), the number of columns and rows chosen per Numset template and the Skip option    (if it
is turned ON).      

The amount of columns multiplied by rows yield the number of cells per template.      If the Skip option is 
ON, only odd or even numbers will make up the range of numbers.      Therefore, as in the example, you 
can calculate the number of templates that will print out.

Skip

The Skip option is only available for Numset and allows you to print either all even or all odd numbers.     
Check the checkbox to turn this option ON.      To print all even numbers, set the first number in the Print 
All dialog box to an even number.      To print all odd numbers, set the first number to an odd number.      

Note the total number of cells per template and the repeat option, if    ON.    Set the last number 
accordingly if you want it to print out.





Example of Repeat option in Print All dialog box

A programmer has designed software for use in-house.      The program is contained on 3 diskettes.      11
copies of the program must be issued company-wide.      The programmer decided to use self-adhesive 
labels with 3 columns and 11 rows of labels per sheet (33 labels total per sheet).      One template is 
needed.

Numset is configured to have 3 columns and 11 rows per template.    The    leading text is "Disk".      The 
trailing text is "of    3".        In the Print All dialog box, a range of 1 to 33 is chosen.      The Skip option is 
OFF.      The Repeat option is ON and set to 11.      One template will print out with 3 columns and 11 rows
of numbers, each row numbered 1 to 3.      This label will appear on each self-adhesive label:

Disk X of    3 ;where X is a sequential whole number between 1 and 3



Print One dialog box

An existing template may become unusable.      Instead of printing another template stack, use Print One
to print a replacement template.      Also use it to print a sample template.      See Quick Start.      To open 
this dialog box, choose Print One from the File menu.      Set the range and the "start at" number in this 
dialog box.      This dialog box is only available for raffle ticket templates.      An explanation follows.

Range

Insert the first and last sequential numbers of the affected template stack.      A valid entry for the first 
sequential number is any number between 0 and 999996, depending on the number format.      A valid 
entry for the last sequential number is any number between 3 and    999999, depending on the number 
format.      The range is required to correctly match sequential numbers printed on the single template 
with sequential numbers on the existing template stack.

The number format setting effects the maximum entry allowed for the last number.      For example, if the 
number format is set at "thousands" then the maximum last number is 9999.

Start At 

Insert the top, leftmost raffle ticket number in the text box with this label.      The first sequential number 
on the first template will start with this number.      

Note: Ensure correct entries for the range and "start at" number.      Get the range by finding the first and 
last templates of the template stack with the unusable template.      Enter the top, leftmost sequential 
number of the unusable template as the "start at' number.

Numbers

Sequential numbers that progress in a forward count.      Raffle ticket sequential numbers can print either 
horizontal or vertical in a template stack.



Raffle Ticket Sequential Numbers

Raffle ticket sequential numbers have leading zeros and are preceded by "No." text.      They have a    
number format range of hundreds to hundred thousands 

Raffle ticket sequential numbers can print either horizontally (descending in a lateral order across a 
template) or vertically (descending in order through each template).        For example: twelve raffle tickets
are needed, numbered 1 to 12.      The number format is Hundreds.      The graph below depicts 
sequential numbers on three templates.      The leading text "No." is not shown for simplification.



Printers

Raffle Do is a printer intensive application.      Close all other programs before printing a template stack.   
Once printing begins, Raffle Do will not yield operation long enough to operate another application.

Raffle Do supports ALL laser printers that MS-Windows 3.0 and higher support.      Raffle Do will print 
templates on Ink Jet and Bubble Jet printers also.      For raffle tickets, use the Print One option to get a 
template sample.      

The automatic feed setting of your printer is recommended.      You might prefer to print templates on 
stock heavier than 20 to 50 Lb. paper.      Most light duty laser printers force you to use the manual feed 
for heavy stock paper.      To use the manual feed, simply follow the instructions for your laser printer's 
user guide and the guidelines suggested in the Windows user's guide.      Next, choose Printer Setup 
from the File menu of Raffle Do.      Chick on the setup button in the Printer Setup dialog box.      Choose 
manual feed in the printer dialog box for Windows 3.1.      If you have Windows 3.0, set the manual 
option by opening the "printers" icon in the Control Panel.      Consult the Windows 3.0 user's guide for 
further information.

Additional Do's and Don'ts:

Make sure that your laser printer is active.
Make sure your laser printer is set to correct print mode (portrait or landscape).
Set all margins on your laser printer to 0.25" or zero.      Change the margin setting of 

your printer to adjust the ticket heading placement on the page, if necessary.      Consult your
printer's user guide for more information on setting margins.

ALWAYS use the Windows Print Manager or a compatible print manager with its 
window setting    for minimum.      This will give you more control when canceling a template 
stack printout.      You can also easily switch to the Print Manager to view the    progress of 
document printing.

Make sure that the printer queue is empty before printing with Raffle Do.      Open the 
Print Manager window to check for any documents.

Make sure that no other application will send a document to the printer while Raffle 
Do is printing.

Use only letter size paper for templates.

Also see
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Timing

The total time to print a template stack is helpful when managing resources under Windows.      Some 
templates may be large, which may take a long time to print.      The speed of the computer and the page
per minute speed of the printer will determine the amount of time it takes to print out a template stack.

Windows 3.0 and 3.1 handle the printing process differently.      Windows 3.0 will send documents to the 
printer almost immediately after configuring them.      Windows 3.1 will configure all documents in a 
temporary file, then print all of them.      This allows Windows 3.1 to configure documents much quicker 
and return control to the user while the document prints.      But a large template stack may not allow 
sufficient control of other resources.

Of course, faster PCs will send templates to the printer at faster intervals.      For large template stacks 
(5000 or more tickets) a very large amount of RAM or hard disk free space may be required unless you 
send a series of smaller template stacks to the printer.

Sample times under Windows 3.0

With the 4x1UP template opened, Raffle Do sent one template every 6 seconds to the printer.      
Therefore, a maximum of ten templates per minute is transferred to the printer per minute.      While 
printing 500 tickets (125 templates with horizontal numbers chosen), the following times    were 
recorded.      The print manager stated the entire document (template stack) was 77 kilobytes.      The 
4x2UP templates had similar times.

0:00:00 printing process initiated
0:00:05 print manager icon appeared on-screen
0:00:30 first template printed
0:20:30 last template printed

Sample times under Windows 3.1

As mentioned earlier, the printing process in Windows 3.1 configures a document in a temporary file, 
then prints it.      The total time to print a template stack is longer, but control is returned to the program 
faster.      While printing the same 500 tickets, with 4x1UP opened and horizontal numbers chosen, the 
following times were recorded.      The print manager stated the entire document was 225 kilobytes.      
The 4x2UP templates had similar times.

0:00:00 printing process initiated
0:00:10 print manager icon appeared on-screen
0:04:00 first template printed
0:24:00 last template printed

A Numset template stack print out under Windows 3.1 was also timed.      The template was configured 
with 3 columns, 11 rows, no leading or trailing text and in portrait.      The number format was none.      
Skip and repeat was OFF.      While printing 330 numbers (10 templates) the following times were 
recorded.      The print manager stated the entire document was 53 kilobytes.      Various other Numset 
configured templates has similar times and consisted of similar size while in the print manager.

0:00:00 printing process initiated
0:00:10 print manager icon appeared on-screen



0:04:10 first template printed
0:05:30 last template printed



Escape Printing

A message box appears when the OK button is clicked in the Print All or Print One dialog box.      It states
the current sequential number printing out and the message "Press the ESC key to cancel".      Raffle Do 
is printing templates while this message box is on-screen.      For horizontal sequential numbers, the 
current number is the last or rightmost sequential number per template.      Therefore, on 4x1UP 
templates, current numbers progress by a factor of four.      4x2UP current numbers progress by a factor 
of eight.

For vertical sequential numbers, the current number is also the last sequential number per template.      It
is found by subtracting the "start at" number from the "last" number and adding one [this is (a)].      Divide
(a) by the number of tickets per template [this is (b)].      Then, subtract (b) from (a).      This is the first 
current number to appear.      Following numbers increase by a factor of four or eight, depending on the 
raffle ticket template used.

When printing Numset templates, the current number starts with the last number in the last cell on the 
first template.      Following numbers increase by a factor of the total number of cells, assuming Repeat 
and Skip are OFF.

Press the ESC key to cancel template stack printing and return control to the main window.      Raffle Do 
will permanently halt and delete printing of the current template stack.      If your printer has on-board 
memory, then you may have to discard the template stack.      If    Windows stores the template stack in a 
temporary file, the file will transfer data to the printer when you cancel the printing process.      The data 
will automatically move into the on-board memory and initiate the printing process.

If you do not use a Print Manager, you may have to discard the template stack.      Consult the user's 
guide for your printer for more information.



Networks

Raffle Do can operate within any MS-Windows 3.0 and higher supported network.      Raffle Do version 
1.0 is a single user software.      Therefore, follow the MS-Windows guidelines for using single user 
applications on networks.      Ensure that the network printer's queue is empty and that no applications 
send documents to the printer while Raffle Do is printing.



Printing and Fonts

Raffle Do has two available fonts: helvetica and times roman.      Windows 3.0 and 3.1 have different 
actual names it sends to the printer for both.      Windows 3.0 states "Helv" for helvetica font and 
Windows 3.1 states "Helvetica".      Windows 3.0 states "Tms Rmn" for times roman font.      Windows 3.1 
does not support times roman font.      An almost identical font is "Times".

Raffle Do automatically searches for the correct name used for helvetica and sends it to the printer.      
Raffle Do will automatically send "Tms Rmn" to the printer under Windows 3.0 and "Times" to the printer 
under Windows 3.1.

When the printing process is initiated, a message box may inform you that the current font chosen in 
Raffle Do is not available on your printer.      If you do not want to print templates in the default font of the 
printer, you can choose the remaining font from the design bar, if available.

In order to have these fonts available, make sure they are installed.      You should add helvetica and 
times roman fonts to the group of available fonts in Windows if they are not installed in the Windows 
directory.      The Windows 3.0 diskettes, number 5 and 6 on 3.5" diskettes, have these fonts.      Consult 
the Windows user's manual for instructions on how to install fonts.



Shortcut and Quick Access Keys

Shortcut Keys

You can operate Raffle Do without the use of a mouse, if necessary.      The shortcut keys for the main 
window are the ALT, ARROW, SPACEBAR, and RETURN keys to access and navigate through the 
menus.      Use the TAB key to access the scroll bars and the PAGE UP, PAGE DOWN, and ARROW 
keys to move the simulated on-screen template with the scroll bars.

The Print One, Print All and Numset dialog boxes have the TAB, ALT, ARROWS and ENTER shortcut 
keys.      Use the TAB key to switch the cursor or set the focus among the controls.      Consult the MS-
Windows user's manual for further information concerning shortcut keys.

Quick Access Keys

The menus in the main window have the only available Quick Access Keys.    Press the following key(s):

Key(s) Action
F1 opens the help file with context sensitive help on the window or dialog box with the focus.
F2 opens 4x1UP raffle ticket template
F3 opens 4x2UP raffle ticket template
F4 opens Numset dialog box
F5 opens the Print All dialog box
F6 opens the Print One dialog box
F7 blanks the currently active raffle ticket label
F8 resets all raffle ticket labels to default setting
F12 displays a message box with an option to terminate operation of Raffle Do
Ctrl+F2 changes the number format of raffle ticket or Numset sequential numbers to Hundreds
Ctrl+F3 changes the number format of raffle ticket or Numset sequential numbers to Thousands
Ctrl+F4 changes the number format of raffle ticket or Numset sequential numbers to Ten 

Thousands
Ctrl+F5 changes the number format of raffle ticket or Numset sequential numbers to Hundred 

Thousands
Ctrl+P opens the Printer Setup dialog box for Windows

Also See
Definitions



Help Menu Commands

Command Action
Index Displays the main index of the help menu for Raffle Do.
Keyboard Displays help for shortcut and quick access keys available for Raffle Do.
Commands Displays help for the file menu, options menu and help menu commands.
Procedures Displays step by step procedures to operate Raffle Do. 
Registration Displays the registration form, commants form and a copy of the license 

agreement.
Using Help Displays WinHelp file with instructions on how to use WinHelp.      Press F1 to 

switch to WinHelp when any help file is opened.
About Displays copyright information for Raffle Do.



Definitions

Body the part of a raffle ticket that contains information on the event or 
occasion; usually text.

Controls objects displayed on the screen, usually in a window or dialog box.      
The basic controls in Raffle Do:

Controls Definition
Command buttons push-button objects that execute an associated command (i.e. "O,K.", 

"CANCEL").
Menu commands menu contents that execute associated commands (i.e. "File", Options").
Labels textual headings for a control    (not the same as definition below).
Text box a box that displays characters the user inputs through a keyboard.

Dialog box a window that displays and requests information.      The dialog box then 
closes and executes code based on the information stated and/or 
chosen.

Focus when a control is highlighted (has the cursor within it or its borders are 
outlined) and can immediately receive input from the user.

Labels for raffle tickets, a label is a customized object, excluding sequential 
numbers, that contains text (i.e. "Name________________").      For 
Numset, a label is a customizable object within each cell.      The Numset 
label is a sequential number alone or with leading and/or trailing text.

Main window the window or screen that displays when Raffle Do starts up and remains
until operation is terminated.

Number format See number format.

Sequential numbers numbers that progress in a forward count.      For raffle tickets, see raffle 
ticket sequential numbers.      Numset sequential numbers can have the 
same number format range as raffle tickets or none at all.      Numset 
sequential numbers are not preceded by preset text unless the user adds
it.

Stubs ticket heading minus the bottom sequential number.      See definition for 
ticket heading below.

Templates a letter size sheet with ticket headings or cells of numbers.      Raffle Do 
offers 4x1UP and 4x2UP raffle ticket templates with headings.      4x1UP 
means there are 4 raffle tickets across one row on a page.      4x2UP 
templates have eight raffle tickets, with 4 tickets across 2 rows on a 
page.      4x1UP templates are printed in landscape mode; 4x2UP are 
printed in portrait mode.      The Numset template has cells of numbers.

Template stack all of the templates, from the first to last printed in one session, become a
template stack.      Template stacks can have more templates added to 
them to increase the size of the stack.      A raffle ticket template stack is 



characterized by having the same headings and number format.      A 
Numset template stack has the same label (the same number format with
identical leading and trailing text).

Ticket heading print at the top of the raffle ticket template.      Includes all visible labels 
and sequential numbers.      An on-screen raffle ticket template displays 
the ticket heading.



Registration

This is an unregistered copy of Raffle Do.      Read the license agreement for more information.      To get 
a printout of the payment form, goto Payment form.      For more information contact Resolutions Now, 
Customer Accts. Dept., P.O. Box 443, Blue Island, IL. 60406-0443.      When you register Raffle Do, you 
will receive these benefits:

A registered copy of Raffle Do v1.0.      Note that both registered and unregistered 
copies include all features.

Free assistance to registered users for 90 days.      User support is by mail only.      
A 10% discount off the price of the latest version of Raffle Do.
A 10% discount off the price of all other Resolutions Now shareware if you register 

this software by 2/28/93.
Free information on new and updated product releases.

Price structure for Raffle Do and support products:
(printed instruction manual available for registered users only)

 

For on-site duplication of the registered copy of Raffle Do

Subtract $5.00 from price of each registered copy for on-site duplication.      One master disk of a 
registered copy at $50.00 is required.      Prices for printed instruction manuals are the same.      The 
maximum fee for on-site duplication of the registered copy is $2,500.00.

Raffle Do is a single user product.      The prices above are for single user computer customers.      Contact
Customer Accounts Dept. of Resolutions Now for prices for using Raffle Do on networks.      Network 
users qualify for the same on-site duplication prices.

Also see:
Payment form
Comments form



Raffle Do Payment Form

Complete this form (see prices).      Choose Help + Print Topic to get a printout.      Use only a street 
address for mailing.      Resolutions Now cannot ship products to Post Office boxes.      The method of 
payment is either a check or money order, drawn on U.S. accounts only.      Make all checks and money 
orders payable to Resolutions Now.      Illinois residents must add applicable sales taxes.

Date:________________

Choose one disk format: ____ (2) 5.25" 360k disks              or              ____ (1) 3.5" 720k disk

Mail check or money order (payable to Resolutions Now) along with this payment form to :
Resolutions Now,    Product Fulfillment Dept.,    P.O. Box 443,    Blue Island, IL.    60406-0443



Comments Form

If you have any suggestions, get a print out (choose Print Topic from the File menu of this help program) 
and write your comments on this form and mail it to:

Resolutions Now
Customer Support Dept.
P.O. Box 443
Blue Island, IL. 60406-0443

Comments:



IMPORTANT Read this license agreement carefully before using this software.      Use of 
this software binds you to the terms of this license agreement.      Do not 
use this software if you do not agree to the terms of this agreement.

LICENSE AGREEMENT - SINGLE USER

The Raffle Do (TM) software is not "Public Domain" or "Freeware".    Raffle Do is 
"Shareware".      This is a single user license.      Registering Raffle Do for use on more than 
one computer may require a Multiple User or Site License.

1. COPYRIGHT.    Raffle Do is copyrighted 1992 and the copyright owner is Philip Rodgers, Jr.
d.b.a. Resolutions Now ("Licensor"), located at P.O. Box 443, Blue Island, IL. 60406-0443.      
All Raffle Do source code files and documentation ("the software") are protected by United 
States copyright laws and international treaty provisions.

2. TRADEMARKS.    "Raffle Do", the Raffle Do icon and "Resolutions Now" are trademarks of 
Philip Rodgers, Jr.

3. GRANT OF LICENSE.      Non-registered users of this software are granted a limited license
to transfer one copy of the non-registered (i.e. unregistered) software to a single hard drive
on a single computer and produce one printed copy of all documentation for evaluation on 
a private non-commercial basis, for the express purpose of determining whether the 
software is suitable to their needs.      The evaluation period is not to exceed 30 days.      At 
the end of the evaluation period, you are required to either register your copy by sending 
the payment as stated in the documentation or discontinue using it and discard all copies 
thereof.

Registered users ("Licensees") are granted a non-exclusive license to transfer one copy of 
the registered software to a single hard drive on a single computer and produce one 
printed copy of all documentation.      Registered users may also make one copy of the 
software for backup or archival purposes.      The software may not be used on a computer 
that is part of any network.      Licensee shall pay Licensor a license fee as stated in the 
documentation after which Licensee shall become a registered user with a fully paid 
license.      Any other uses may require a Multiple User or Site License.      

You may reproduce and distribute copies of the non-registered Raffle Do software, subject 
to the limitations stated herein, and on the express condition that you do not receive any 
commercial benefit or other compensation.      The recipient(s) to whom you distribute this 
software must agree to the terms of this Agreement, including the payment of the stated 
Licensee fees to Licensor upon becoming registered users.

Distributors of user-supported software libraries (i.e. operators of electronic bulletin 
boards, shareware vendors) that charge a disk fee must obtain written permission of Philip 
Rodgers, Jr. to distribute non-registered copies of Raffle Do.

4. RESTRICTIONS.      Except as provided herein, you may not rent, lease, sub-license or 
otherwise redistribute Raffle Do.      You may not reverse engineer, decompile or 
disassemble the software.

U.S. Government Restricted Rights:    Use, duplication or disclosure by the U.S. Government
is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical 
Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c) (1) and 
(2) of the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as 
applicable.      Contractor/Manufacturer is Philip Rodgers, Jr. d.b.a. Resolutions Now, P.O. Box
443, Blue Island, IL. 60406-0443.



5. WARRANTY DISCLAIMER.      THE RAFFLE DO SOFTWARE IS LICENSED "AS IS" WITHOUT 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR IMPLIED WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE.    IN 
NO EVENT SHALL THE LICENSOR BE LIABLE FOR DAMAGES, INCLUDING ANY LOST PROFITS 
OR INCIDENTAL AND CONSEQUENTIAL DAMAGES, EVEN IF THE LICENSOR HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.      


